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Welcome to Trimble Business Center 

Trimble Business Center (TBC) provides a complete office software solution for survey and construction 
professionals. Having the ability to work in a single software environment streamlines operational 
efficiency while minimizing the costs of data management, software maintenance, and training.  

Important Note! This version of Trimble Business Center is available to:  

 Perpetual license users whose current warranty expiration date is November 1, 2025 or later. (If 
your perpetual license warranty expires prior to this date and you proceed with the installation, 
licensed features will not be available.) 

 Subscription license users whose subscription is currently active.  

If necessary, you can contact your distributor to purchase a warranty extension or renew your 
subscription. In the TBC ribbon, select Support > License Manager to view your warranty or subscription 
expiration date. 

New features 

Following are the new features and enhancements included in this version of Trimble Business Center. 
To view context-sensitive help in TBC while using any of the commands mentioned here, simply press 
F1. 

Miscellaneous 

 Windows 10 support ending - TBC will end support for Windows 10 on October 14, 2025.  

 Add custom fields for site improvements - In Project Settings, you can now enable and 
name user-defined fields for use in site improvement definitions in the Material and Site 
improvement Manager. The values you enter in these custom fields are also shown in the 
Earthwork Summary Report. The fields allow you, for example, to include additional 
information, like an associated part number, for more accurate bidding. As a project setting, 
these fields can also be saved into project templates for consistency across your projects. 
(See Custom Field Settings in the help.) 

 New antenna support - TBC now supports the following antennas: 

 EFIX eBase GNSS 

 GeoMate GAT10 w/GMTC 

 GeoMate SG5 

 GeoMate SG7 

 GINTEC CY F90 

 Harxon HX-CGX611A 

 Leica GS15 
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 Septentrio PolaNt-x MF.v2 

 STONEX SA1100 

 STONEX SA1500 w/STXG 

 Teria PYX.R1 

Find more information at https://www.ngs.noaa.gov/ANTCAL/. 

 Updated Coordinate System Database - The newest Coordinate System Database v113 
includes the following enhancements: 

 Added the beta version of US SPCS 2022. 

 Added support for ETRS89-DREF91(R25), used in Germany. 

 Added support for NGD2012, used in Nigeria. 

 Added support for CR-SIRGAS at epoch 2014.59, used in Costa Rica. 

 Added a new geoid RGM23v2 for Mayotte. 

 Updated the displacement model for Mexico. 

 Updated the displacement model REDGEOMIN, used in the mining industry in Chile. 

 Updated Coordinate System Database - The newest Coordinate System Database v114 
includes the following enhancements: 

 Added support for REGPMOC, used in Peru. 

 Added support for SIRGAS-ES2007.8, used in El Salvador. 

 Added support for LKS-2020, used in Latvia. 

 Added support for CSRN2025, used in California. 

 Added support for SIRGAS-Chile 2025, used in Chile. 

 Added support for SRGI2013, used in Indonesia. 

 Added EGM 2008 for Italy. 

 Added EGM 2008 for Saudi Arabia. 

 Added EGM 2008 for Nicaragua. 
 

Data Exchange and management 

 Export to Microstation DGN - You can now use the MicroStation DGN exporter to export 
various types of data in your project, including lines, polylines, linestrings, arcs, circles, 
ellipses, splines, text, multilines, meshes, linear and angular dimensions, and block 
references, to .dgn files that can be opened in Bentley MicroStation and other design tools, 
along with numerous field devices. (See Export Bentley MicroStation Files (.dgn) in the 
help.) 

https://www.ngs.noaa.gov/ANTCAL/
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 LandXML Importer and Exporter upgrade - The LandXML importer and exporter (also used 
in the 'File Flipper') have been upgraded from the previous TBC format (LandXML v1.2 from 
January 2015) to the latest ISO (International Organization for Standardization) standard 
(ISO 15143-4, 2025). Using this open LandXML schema, which supports points, lines, 
alignments, corridors, surfaces, and other data types, will improve interoperability within 
Trimble workflows and compatibility with 3rd-party tools. The new ISO format supports a 
slightly different set of data types, so when exporting, you can also choose between ISO 
15143-4 and TBC 1.2 formats.  (See Export LandXML Files (.xml) in the help.) 

 Use Connected Workspace to transfer project files between TBC and Trimble Access - 
Connected Workspace now enables users to configure a feature code library (.fxl) to a 
Trimble Connect project, making office-to-field workflows easier and less prone to error. 
Transfer TBC projects through Trimble Cloud, which enables you to back up and share 
projects with other users designated in your Trimble Connect project. (See Share Projects 
and data Using Connected Workspace in the help.) 

 Exporting Data in Connected Workspace - While using Connected Workspace, use the 
Remote save command to export files. 

 Some functions in Connected Workspace require a TBC subscription license - In Connected 
Workspace, the Workspace tab is only available to clients with a TBC subscription license. If 
you are using a Perpetual license, the functionality of the tab is disabled. 

 

Survey and COGO 

 Scale ground coordinates from 0,0 - When importing data into your project, you now have 
an option to automatically scale ground coordinates from 0,0, which created issues when 
0,0 was outside the area of validity of the selected Coordinate System. You still have the 
option to scale ground coordinates from the project location. This new option streamlines 
your workflow by eliminating the need to manually enter a project location of 0,0. (See 
Specify Local Site Settings in the help.) 

 JXL/JOB compatibility with older versions of Trimble Access and Trimble Business Center - 
JXL/JOB files created using the new scaling 0,0 feature are not compatible with Trimble 
Access and Trimble Business Center prior to 2025.20. They can be imported in Trimble 
Business Center prior to 2025.20, but they will produce the wrong coordinates. (See Specify 
Local Site Settings in the help.) 

 

GIS 

 Write only new and updated data to GIS - When using the Write Features to GIS command 
to upload (write) processed feature data back to the GIS data source, new and updated 
features are automatically selected for upload. This eliminates the need to select the 
features individually. (See Upload (Write) Processed Features to a GIS Data Source in the 
help.) 
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 Enhanced Feature Attribute and raw data handling - Feature attributes values are now 
synchronized with imported raw data, such as .job or .jxl imports. Now when you change 
attributes on features with raw data, the values are synchronized. This means changed 
feature attributes (Properties) are updated in the raw data (Feature Code Editor) and vice 
versa. Process Feature Codes resets all attributes to raw data. Process features without raw 
data will not change. Objects such as points or lines with feature attributes that were set in 
Properties have no raw data, and will not change. 

 New support for Autofields - TBC can now automatically fill point attribute data, such as the 
area of a polygon, line length, local and global coordinates, elevations, point numbers, or 
codes, TBC and the Feature Definition Manager is extended with new EntryMethods to fit 
this purpose. (See the Feature Definition Manager help.) 

 

CAD 

 Save snap modes as Snap Sets - The new Snap set function allows you to save your snap 
settings by user and quickly retrieve them in any project. Four snap sets are predefined. Use 
CTRL + SHIFT + S to toggle through the snap sets. (See Running Snap Mode Options and Set 
Running Snap Modes in the help.) 

 Crosshair cursor in the Plan View - The cursor in the Plan View now shows as a crosshair, 
making it easier to see the cursor's position. Configure the size of the crosshair in Options > 
General > Display > Crosshair pixels. 

 Change the scale bar color - You can now adjust the color of the scale bar in the Plan View, 
under Project Settings > View > Plan View > Grid Options. (See Change the Gridline Display 
in the help.)  

 Change the plot scale in the status bar - See and quickly change the current plot scale in the 
TBC status bar, either in 1:<scale factor> (metric) or 1’=<scale factor>’’ (feet).   

 

Point Clouds 

 Target-based point cloud registration - The Target-based registration command has been 
added to support the automatic and manual extraction of placed targets in point clouds and 
use them to register the scans with a target-based registration algorithm. There are three 
target types supported: 

 Spherical targets, which can be extracted automatically and manually. This offers a 
number of default sizes, as well as the ability to set custom values 

 Checkerboard targets, which can be extracted automatically and manually, and can be 
edited if needed 

 Points, which can only be created manually, then matched to other points 

This enables scans with fewer distinct features to be registered together easily and 
precisely, and enables precise observation of control points for georeferencing. (See Target-
Based Registration of Point Clouds in the help.) 
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 Extract BIM lines - Use the new Extract BIM lines command to create linestring copies of 
each selected BIM object that contains line segments and arcs. (See Create Points from BIM 
Objects in the help.) 

 

Photogrammetry 

 New DSM engine - TBC has a new engine to run DSM processing in 2.5D and 3D, including 
dense point clouds, true-orthophotos and textured meshes. It handles resources better and 
improves radiometry and accuracy, and the user interface has been simplified. It enables 
you to process the same type of data you ran before, but the quality of thin structures is 
improved and the geometric representation of vertical sign posts, light poles, industrial 
construction pipes, and cables is retained. 

 

Tunnels 

 Filter views by tunnel set out - Tunnel set outs are now shown in the View Filter Manager, 
allowing you to toggle visibility for each of the five tunnel set out types (blast hole, 
horizontal, pipe, radial, and vertical) on and off in 3D, Plan, Station, and other views. 

 

Mines 

 Tonnage Reporting Now Available for Stockpile and Conformance Reports - We've added a 
Specific Gravity input field to the Stockpile Report and the Mine Design Conformance 
Report. Simply enter the material's specific gravity, and the reports will automatically 
calculate and display total tonnage alongside volume, providing a more complete picture for 
mine material reporting. 

 

Mobile Mapping 

 TBC now integrated with AgileAssets - TBC is now integrated with AgileAssets. Seamlessly 
pass information about pavement condition generated in TBC to Pavement Analyst - ALM 
platform for pavement management. Log in to AgileAssets from TBC, pull the road network 
from AgileAssets, run pavement inspection analysis, and export pavement condition reports 
directly into AgileAssets. 

 Improved Pavement Condition Inspection (PCI) visualization - Performance when 
visualizing PCI elements, such as blocks, sample units, segments, and conditions, has been 
improved. 

 Enhancements to line feature extraction for curb and gutter - The Inspect pavement 
condition curb and gutter extraction feature has been enhanced in several ways. Users can 
now add and remove node patterns when a curb pattern changes, such as when a curb is 
interrupted by a driveway, gutter, or inlet. Node patterns can be saved and reused. Search 
through and edit individual nodes using the left and right buttons. (See Inspect Pavement 
Condition in the help.) 

 Process multiple lanes during pavement inspection - Use the new Select lane lines feature 
to process multiple lanes in Inspect pavement condition. (see Inspect Pavement Condition 
in the help.) 
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 Select multiple runs to create an orthomosaic for pavement inspection - When a single 
mobile mapping mission includes several runs, users need to create pavement orthomosaics 
and conduct inspections for each one. This new feature allows batch input of multiple runs, 
enabling users to process all runs more efficiently. 

 

Drafting 

 Sheet view enhancements - There are several new enhancements to the sheet view. (See 
Use a Sheet View in the help.) 

 The sheet view displays the correct paper size of the sheet against a dark background, 
enabling you to see the sheet size exactly as in AutoCAD. Switch this off by disabling 
Display white background for the Sheet View under Options > General > Display. 

 Switch between different sheets using the left and right arrows at the bottom of the 
sheet view. 

 Automatically open the Print Plan Set pane with the Print button. The Print Plan Set is 
populated with the current plan set, sheet set, and sheet.  

 When the Sheet view is open, the displayed sheet is synchronized with the selected 
sheet in the Project manager. Double click on Sheets, Sheet sets or Plan sets in Project 
explorer to open Sheet view. Click to see the sheet or sheet set Sheet view. To improve 
clarity, you can only have one sheet view window open in TBC. 

 

Third-party tools 

 ANZ Toolbox – New commands in the ANZ Toolbox include: 

 Fix Media Links – The Fix Media Links command allows you to update and fix broken 
media file paths on points within TBC projects. This can be useful if you export job data 
as a VCL file and bring it into another TBC project as the links will be broken. The 
command also makes it possible to easily move the media files from the project folder 
where they were imported to a more centralized folder location. 

 Match Attribute Values - The Match Attributes Values command allows you to select a 
source object containing feature attributes and copy the values to target objects with 
the same attribute names. It is important to note that the features do not need to be 
the same and it can be used between points, lines, and polygons. Doing this will not 
create new attributes (that do not already exist) on the target objects. 

 Map Feature Attribute - The Map Feature Attributes command enables you to create a 
mapping rule set that will select a group of objects using all or part of an object name, 
code, or feature (using the wildcard asterisk "*") and apply a new feature and 
predefined attribute values to those objects simultaneously. These rule sets can then be 
saved and reused as needed. 

 Extend Lines to Surface - The Extend Lines to Surface command allows you to select one 
or multiple lines and extend them on grade to intersect a surface or just extend to a set 
elevation. 

(See Commands in the ANZ Toolbox Module in the help.) 
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Important notes and known issues 

See the TBC Help for a complete, up-to-date list of important notes and known issues related to TBC. 

System requirements 

Microsoft operating system: Windows 11 (64-bit version) 

Processor:  Dual-core 1.80 GHz or better minimum 

Quad-core 3.0 GHz or better recommended (additional cores with 
hyper-threading support highly recommended for Aerial 
Photogrammetry and Scanning modules) 

Intel Core Ultra 9 285K or equivalent for large Mobile Mapping 
data sets (for example, eight runs totaling 75 kilometers) 

Important! Because components of TBC make use of Intel-only 
multi-thread processing, AMD Ryzen processors are not 
supported. 

Random access memory (RAM): 4 GB or more recommended 

32 GB minimum, 128 GB or more recommended for Aerial 
Photogrammetry and Scanning modules 

196 GB DDR5 for large Mobile Mapping data sets (for example, 
eight runs totaling 75 kilometers). LIDARQC run alignment process 
requires a high amount of memory for alignment of large projects. 
If only processing MX50 or MX60 data, smaller amounts of RAM 
are sufficient, but 128 GB would still be recommended. 

Hard disk space available: 30 GB or more recommended 

100 GB or more on solid-state drive required for Aerial 
Photogrammetry, Mobile Mapping, and Scanning modules 

The recommended SSD overall hard drive capacity is 2 TB or more 
for Aerial Photogrammetry and Scanning modules  

Storage: 12TB 7200rpm or higher HDD or SATA SSD for large 
Mobile Mapping data sets (for example, eight runs totaling 75 
kilometers) 

Boot: Samsung 9100  Pro M.2 NVMe (or equivalent) for large 
Mobile Mapping data sets (for example, eight runs totaling 75 
kilometers) 

Monitor: 1280 x 1024 or higher resolution with 256 or more colors (at 96 
DPI) 

I/O Ports: USB 2.0 port required if HASP hardware key is used 
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Graphics: DirectX 11 compatible graphics card with 512 MB memory or 
more  

OpenGL version 3.2 or later required when working with point 
cloud data (latest version recommended) 

10 GB or higher graphics card (for example, NVIDIA Quadro P4000) 
recommended when working with Aerial Photogrammetry and 
Scanning modules 

Nvidia RTX 5080 16GB GDDR7 or higher for large Mobile Mapping 
data sets (for example, eight runs totaling 75 kilometers) 

Note: 6 GB or higher NVIDIA graphics card with CUDA compute 
capability (5.0 or higher) required when working with point cloud 
classification. 

Note: If you are using a laptop computer with both an integrated 
(on-board) graphics card and a discrete NVIDIA graphics card 
enabled via Optimus technology, your computer must allow you 
to select to disable the integrated graphics card and use only the 
discrete graphics card when working with point cloud data. See 
"Disabling a laptop integrated graphics card" in the "Important 
Notes" topic in the TBC Help. 

Important!  
It is critical that you keep your graphics driver(s) updated if you are working with point 
cloud data.  

Whether your computer has one or multiple graphics cards installed, you must ensure each 
has been updated with the latest driver provided by the card's manufacturer. The best way 
to determine if your driver needs to be updated and, if so, perform the update is to visit the 
card manufacturer's website. For more information, see "Update and Configure Your 
Graphics/Video Driver" in the online Help. 

(If, instead, you decide to update your driver using the Windows Device Manager and the 
"Search automatically" option, the program may suggest using a Microsoft-approved WHQL 
version of the driver. However, to ensure you have the latest bug fixes and new features for 
your graphics card, it is recommended that you use the latest manufacturer version 
instead.) 
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